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Preface
This guide explains the integration between Service Desk and 
Operations Manager for Windows®. With the information in this guide 
you can install, configure and perform the various tasks available with 
this integration. 

This guide is intended for IT administrators who will install and 
configure the integration, and for users who will perform the integration 
tasks. 

To install and configure the integration you must have knowledge of both 
the Operations Manager application and Service Desk.

This guide is organized as follows:

• Chapter 1, “Introduction.” describes the architecture of the 
Operations Manager Integration and gives a brief explanation of 
what the integration possibilities are.

• Chapter 2, “Installation.” describes the installation steps that need 
to be performed on Service Desk and on your Operations Manager 
server.

• Chapter 3, “Operations Manager for Windows and Service Desk 
Configuration.” explains how to configure the integration if you are 
using Operations Manager for Windows.

• Chapter 4, “User Tasks.” provides examples on how to use the 
different features supplied with this integration.

• Chapter 5, “Troubleshooting.” contains information on the default 
locations of installed files and other information that may be helpful 
in solving problems with the integration.

• Appendix A “Sample File Contents” contains example configuration 
files provided with the integration.
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Revision History

When an edition of a manual is issued with a software release, it has 
been reviewed and tested and is therefore considered correct at the date 
of publication. However, errors in the software or documentation that 
were unknown at the time of release, or important new developments, 
may necessitate the release of a service pack that includes revised 
documentation. Revised documentation may also be published on the 
Internet, see “We Welcome Your Comments!” in this preface for the URL. 

A revised edition will display change bars in the left-hand margin to 
indicate revised text. These change bars will only mark the text that has 
been edited or inserted since the previous edition or revised edition.

When a revised edition of this document is published, the latest revised 
edition nullifies all previous editions.

Summary of Changes
Fourth edition (to modify)

The fourth edition contains changes with regard to Operations Manager 
for Windows. There are also changes to some described procedures 
within the manual. All changes are marked with change bars.

Table 1 Revision History

Edition and Revision 
Number Issue Date Product Release

First Edition July, 2002 Service Desk 4.5, 

Second Edition October, 2002 Service Desk 4.5, 
Integration Pack 1

Third Edition March, 2003 Service Desk 4.5, 
Service Pack (SP) 2

Fourth Edition January, 2008 Service Desk 4.5, 
Integration Pack 2
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Related Publications
This section helps you find information that is related to the information 
in this guide. It gives an overview of the Service Desk documentation and 
lists other publications you may need to refer to when using this guide.

The Service Desk Documentation
Service Desk provides a selection of books and online help to assist you in 
using Service Desk and improve your understanding of the underlying 
concepts. This section illustrates what information is available and 
where you can find it.

NOTE This section lists the publications provided with Service Desk 4.5. 
Updates of publications and additional publications may be provided in 
later service packs. For an overview of the documentation provided in 
service packs, please refer to the readme file of the latest service pack. 
The service packs and the latest versions of publications are available on 
the Internet, http://support.openview.hp.com/patches/patch_index.jsp 
and http://support.openview.hp.com/selfsolve/manuals respectively. See 
the section “We Welcome Your Comments!” in this preface for the URLs.

• The Readme.htm files on the Service Desk CD-ROMs contain 
information that will help you get started with Service Desk. The 
Readme files also contain any last-minute information that became 
available after the other documentation went to manufacturing. 

The Service Desk 4.5 server is coded in Pure Java and is platform 
independent. The installation software for each platform varies. 
Service Desk is therefore distributed on three CD-ROMs, one each 
for Microsoft Windows (2000 and NT4), HP-UX, and Sun Solaris. A 
different readme file is available on each CD-ROM. 

• The HP OpenView Service Desk: Release Notes give a description of 
the features that Service Desk provides. In addition, they give 
information that helps you:

— compare the current software’s features with those available in 
previous versions of the software;

— solve known problems.
 11



The Release Notes are available as a PDF file on the HP OpenView 
Service Desk 4.5 for Windows CD-ROM . The file name is 
Release_Notes.pdf.

• The HP OpenView Service Desk: User’s Guide introduces you to the 
key concepts behind Service Desk. It gives an overview of what you 
can do with Service Desk and explains typical tasks of different types 
of Service Desk users. Scenario descriptions are provided as 
examples of how the described features could be implemented.

The User’s Guide is available as a PDF file on the HP OpenView 
Service Desk 4.5 for Windows CD-ROM. The file name is 
User’s_Guide.pdf.

• The HP OpenView Service Desk: Supported Platforms List contains 
information that helps you determine software requirements. It lists 
the software versions supported by Hewlett-Packard for Service Desk 
4.5.

The Supported Platforms List is available as a PDF file on the HP 
OpenView Service Desk 4.5 for Windows CD-ROM. The file name is 
Supported_Platforms_List.pdf.

• The HP OpenView Service Desk: Installation Guide covers all aspects 
of installing Service Desk.

The Installation Guide is available as a PDF file on the HP 
OpenView Service Desk 4.5 for Windows CD-ROM. The file name is 
Installation_Guide.pdf.

• The HP OpenView Service Desk: Administrator’s Guide provides 
information that helps application administrators to set up and 
maintain the Service Desk application server for client usability. 

The Administrator’s Guide is available as a PDF file on the HP 
OpenView Service Desk 4.5 for Windows CD-ROM. The file name is 
Administrator’s_Guide.pdf.

• The HP OpenView Service Desk: Data Exchange Administrator’s 
Guide explains the underlying concepts of the data exchange process 
and gives instructions on exporting data from external applications 
and importing it into Service Desk. The data exchange process 
includes importing single service events and batches of data. 

The Data Exchange Administrator’s Guide is available as a PDF file 
on the HP OpenView Service Desk 4.5 for Windows CD-ROM. The 
file name is Data_Exchange.pdf.
12



• The HP OpenView Service Desk: Migration Guide provides a detailed 
overview of the migration from ITSM to Service Desk, to include an 
analysis of the differences in the two applications. Detailed 
instructions in this guide lead through the installation, configuration 
and other tasks required for a successful migration. 

The Migration Guide is available as a PDF file on the HP OpenView 
Service Desk 4.5 for Windows CD-ROM. The file name is 
Migration_Guide.pdf.

• The HP OpenView Service Desk: Web API Programmer’s Guide 
contains information that will help you create customized 
integrations with Service Desk using the Service Desk Web API. This 
API is particularly suited for developing Web applications. 

The Web API Programmer’s Guide is available as a PDF file on the 
HP OpenView Service Desk 4.5 for Windows CD-ROM. The file name 
is Web_API_pg.pdf.

• The HP OpenView Service Desk: Data Dictionary contains helpful 
information about the structure of the application.

The Data Dictionary is available as an HTML file on the HP 
OpenView Service Desk 4.5 for Windows CD-ROM. The file name is 
Data_Dictionary.htm.

• The HP OpenView Service Desk 4.5 Computer Based Training (CBT) 
CD-ROM is intended to assist you in learning about the functionality 
of HP OpenView Service Desk 4.5 from both a user and a system 
administrator perspective. The CD-ROM contains demonstration 
videos and accompanying texts that explain and show how to 
perform a wide variety of tasks within the application. The CBT also 
explains the basic concepts of the Service Desk application. 

The HP OpenView Service Desk 4.5 Computer Based Training (CBT) 
CD-ROM will be shipped automatically with the regular Service 
Desk software. The CBT will be available for shipment shortly after 
the release of the Service Desk software.

• The online help is an extensive information system providing:

— procedural information to help you perform tasks, whether you 
are a novice or an experienced user;

— background and overview information to help you improve your 
understanding of the underlying concepts and structure of 
Service Desk;
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— information about error messages that may appear when 
working with Service Desk, together with information on solving 
these errors;

— help on help to learn more about the online help.

The online help is automatically installed as part of the Service Desk 
application and can be invoked from within Service Desk. See the 
following section entitled “Using the Online Help” for more 
information.

Reading PDF Files
You can view and print the PDF files with Adobe® Acrobat® Reader. 
This software is included on the HP OpenView Service Desk 4.5 
CD-ROM. For installation instructions, see the readme.htm file on the 
CD-ROM.

The latest version of Adobe Acrobat Reader is also freely available from 
Adobe’s Internet site at http://www.adobe.com.

Using the Online Help
You can invoke help from within Service Desk in the following ways:

• To get help for the window or dialog box you are working in, do one of 
the following:

— Press F1.

— Click the help toolbar button .

— Choose Help from the Help menu.

— Click the help command button  in a dialog box. 

• To search for help on a specific subject using the table of contents or 
the index of the help system: choose Help Contents & Index from 
the Help menu.

When you are in the help viewer, you can find help on how to use the help 
system itself by clicking the Help toolbar button:

Service Desk also provides tooltips and “What’s This?” help for screen 
items like buttons, boxes, and menus.
14
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A tooltip is a short description of a screen item. To view a tooltip, rest the 
mouse pointer on the screen item. The tooltip will appear at the position 
of the mouse pointer.

“What’s This?” help is a brief explanation of how to use a screen item. 
“What’s This?” help generally gives more information than tooltips. To 
view “What’s This?” help:

1. First activate the “What’s This?” mouse pointer in one of the 
following ways:

• Press Shift+F1.

• Click the “What’s This?” toolbar button .

• Choose What’s This? from the Help menu.

• In dialog boxes, click the question mark button  in the title bar. 

The mouse pointer changes to a “What’s This?” mouse pointer .

2. Then click the screen item for which you want information. The 
“What’s This?” help information appears in a pop-up window.

To close the pop-up window, click anywhere on the screen or press any 
key on your keyboard.

Other Related Publications
In addition to the Service Desk documentation mentioned above, you 
may want to refer to the following publication when using this guide:

• HP Operations Manager for Windows: Installation Guide
 15



Typographic Conventions
The table below illustrates the typographic conventions used in this 
guide.

Table 2 Typographic Conventions

Font What the Font 
Represents Example

Italic References to book titles See also the HP OpenView 
Service Desk: Installation 
Guide.

Emphasized text Do not delete the System 
user.

Bold First-time use of a term 
that is explained in the 
glossary

The service call is the 
basis for incident 
registration.

Courier Menu names You can adjust the data 
view with the commands 
in the View menu.

Menu commands Choose Save from the 
menu.

Button names Click Add to open the Add 
Service Call dialog box.

File names To start the installation, 
double-click setup.htm.

Computer-generated 
output, such as command 
lines and program listings

If the system displays the 
text
C:\>dir a:
The device is not 
ready
then check if the disk is 
placed in the disk drive.

Courier 
bold

User input: text that you 
must enter in a box or after 
a command line

If the service call must be 
solved within 30 minutes, 
enter 30.
16



Courier 
italic

Replaceable text: text that 
you must replace by the text 
that is appropriate for your 
situation

Go to the folder 
X:\\Setup, where X is your 
CD-ROM drive.

Helvetica 
bold

Keyboard keys

A plus sign (+) means you 
must press the first key (Ctrl 
in the example), hold it, and 
then press the second key 
(F1 in the example).

Press Ctrl+F1.

Table 2 Typographic Conventions (Continued)

Font What the Font 
Represents Example
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We Welcome Your Comments!
Your comments and suggestions help us understand your needs, and 
better meet them. We are interested in what you think of this manual 
and invite you to alert us to problems or suggest improvements. You can 
submit your comments through the Internet, using the HP OpenView 
Documentation Comments Web site at the following URL:

http://support.openview.hp.com/selfsolve/feedback

If you encounter errors that impair your ability to use the product, please 
contact the HP Response Center or your support representative.

The latest versions of OpenView product manuals, including Service 
Desk manuals, are available on the HP OpenView Manuals Web site at 
the following URL:

http://support.openview.hp.com/selfsolve/manuals

Software patches and documentation updates that occur after a product 
release, will be available on the HP OpenView Software Patches Web site 
at the following URL:

http://support.openview.hp.com/patches/patch_index.jsp
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1 Introduction

The Operations Manager Integration includes a variety of different 
integration options. This chapter provides a brief explanation of the 
architecture and the integration options available.
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The Architecture
The Operation Manager integration is available for Operations Manager 
for Windows. Figure 1-1 shows the integration possibilities and their 
architecture:

Figure 1-1 Operations Manager Integration

The term event integration is used for the integration possibilities that 
are available without an Operations Manager agent being required on 
the Service Desk client. 
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Event integration allows Operations Manager users to send event 
information to Service Desk, and have a corresponding incident in 
Service Desk created. The mechanism used depends on the Operations 
Manager server platform, and Operations Manager for Windows uses a 
Windows Management Interface (WMI) policy. Another integration 
possibility allows annotations to be sent to Operations Manager when an 
incident changes, and an acknowledgement to be sent when the incident 
is closed.

If the Operations Manager agent is installed on the Service Desk client, 
Operations Manager can monitor the Service Desk application to ensure 
that the integration is functioning properly. Service Desk users can 
forward an incident to Operations Manager. This requires the 
configuring of smart actions. Alternatively, the Operations Manager 
agent can monitor the Server Desk log files and, in the event of problems, 
notify the Operations Manager Management Server.

A number of smart actions are provided for the integration, including the 
possibility for users to send messages to the Operations Manager 
application to notify that a problem has been detected. For Windows, the 
opcmsg application is required.

 The Operations Manager for Windows Management Console must be 
installed on the same machine as the Service Desk client. It allows 
Operations Manager GUI to call the Service Desk client on the same 
machine and view nodes and incidents.

Operations Manager managed nodes can be monitored in Service Desk. 
It is also possible to relate Service Desk incidents to Operations Manager 
services. To enable this, each node and service must be registered as a 
configuration item in Service Desk. Data Exchange can be used to 
automate the process of extracting the node and service information from 
Operations Manager and importing it into Service Desk.

NOTE For the purposes of clarity, the communication links between the servers 
and their respective clients. are not shown in Figure 1-1.
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Integration Possibilities
The Service Desk integration with Operations Manager makes it 
possible to:

• Import nodes and services into Service Desk.

• Send events from Operations Manager to Service Desk.

• Reflect Operations Manager updates in Service Desk.

• Send acknowledgment messages and message annotations from 
Service Desk to Operations Manager.

• View Service Desk configuration items and incidents from 
Operations Manager 

• View Operations Manager service state from a browser.

• Generate an Operations Manager message from Service Desk.

• Monitor Service Desk processes and error log files.

These integration possibilities are not available for every platform. The 
supported platform combinations are shown in Table 1-1:

Table 1-1 Integration Possibilities

Integration possibility / Service Desk 
and OM Components / Platform

Service Desk OM

Client Application 
Server

OM Server

Import nodes and services into 
Service Desk

X X X

Sending events from OM X X X

Reflecting updates done in OM X X X

Sending annotations and 
acknowledgements

X X X
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Importing Nodes and Services into Service Desk

Node information from Operations Manager can be extracted and 
imported into Service Desk as configuration items. 

For more information, see “Importing Nodes into Service Desk” on 
page 64.

Sending Events From Operations Manager

Operations Manager can forward messages to Service Desk and create 
corresponding incidents in Service Desk. 

For more information, see “Sending Events From Operations Manager” 
on page 66.

Reflecting Updates Done in Operations Manager

Changes made to Operations Manager messages from the Operations 
Manager management console or the API will be reflected in Service 
Desk. 

For more information, see “Reflecting Updates Done in Operations 
Manager” on page 67.

Sending Annotations and Acknowledgments 

Annotations can be sent to Operations Manager when an incident 
changes, and an acknowledgement can be sent when the incident is 
closed.

Viewing Service Desk CIs and 
incidents from OM

X X X

Generating an OM message from 
Service Desk

X X X

Monitoring Service Desk and 
integration processes

- X X

Table 1-1 Integration Possibilities (Continued)
Chapter 1 23



Introduction
Integration Possibilities
For more information, see “Sending Annotations to Operations Manager” 
on page 68, and “Sending Acknowledgments to Operations Manager” on 
page 69.

Viewing Service Desk CIs from Operations Manager

Operations Manager users can select a node in Operations Manager and 
launch a tool for opening the corresponding incidents for that 
configuration item in Service Desk. 

The Service Desk client and Operations Manager client must be installed 
on the same machine, and the agents for both clients must be on that 
machine. 

For more information, see “Viewing Service Desk CIs from Operations 
Manager” on page 24 for configuration information, and “Viewing 
Service Desk CIs from Operations Manager” on page 70 for information 
on using the feature.

Viewing Operations Manager Service State From a 
Browser

After installing and configuring one of the recommended Web Servers, 
the Operations Manager service state can be viewed from a browser 
within Service Desk. 

For more information, see “Viewing Operations Manager Service State” 
on page 71.

Generating an Operations Manager Message From 
Service Desk

An error message can be created within OM from a Service Desk 
incident. 

For more information, see “Generate an Operations Manager Message 
from Service Desk” on page 54, and “Generating an Operations Manager 
Message From Service Desk” on page 73.

Monitoring Service Desk and Integration Processes

You can monitor errors in the Service Desk application server and the 
Operations Manager management server. 
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For more information, see “Monitoring Service Desk Processes” on 
page 74.
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Fast-Track Installation and Configuration
This section provides a brief overview of the steps required to get your 
Operations Manager integration up and running. 

Do the following:

1. Install the Service Desk Event Handler on the Operations Manager 
server. For Operations Manager for Windows, follow the instructions 
in the readme file in the integration Service Pack for Operations 
Manager for Windows.

2. If you intend to view Operations Manager services from a browser, 
you need to install the HTML Service Event Viewer, follow the 
instructions in “Installing the HTML Service Viewer” on page 32.

3. Enable the database rules in Service Desk for acknowledgement and 
annotations. Follow the instructions in “Configuring Database Rules” 
on page 48.

4. Within the Service Desk application server Administrator Console, 
create an account for each required Operations Manager 
Management Server. Follow the instructions in “Creating an 
Operations Manager Server Account” on page 37.
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2 Installation 

This chapter explains the installation tasks for the Service Desk 
application server, Operations Manager for Windows server.
Chapter 2 27



Installation
Requirements
Requirements
Refer to the HP OpenView Service Desk: Installation Guide for detailed 
information on system requirements.
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Installation Overview
The Operations Manager Integration includes a number of files and tools 
that need to be installed on the Service Desk and the Operations 
Manager servers. The following checklist shows the recommended order 
of installation:

1. Verify that the database server is installed and operational;

2. Operations Manager application (refer to the Operations Manager 
documentation);

3. Web Server supplied with the Operations Manager application (refer 
to the Operations Manager documentation);

4. Service Desk server application;

5. Service Desk database;

6. Operations Manager agents on Service Desk server (refer to the 
Operations Manager documentation);

7. On your Operations Manager for Windows server:

• Follow the instructions in the Readme file distributed with the 
Integration service pack for Operations Manager for Windows 
8.0.

• Service Desk agents on all Operations Manager for Windows 
machines.

• OvServiceExport.exe is included in the Integration pack if you 
want to use the HTML Service Viewer.

TIP Operations Manager for Windows users can use either the Apache, or the 
Microsoft® IIS Web server supplied with Operations Manager. 

To check if Microsoft IIS is installed, type the following in your browser: 
http://<server>/scripts/OvServiceExport.exe?-format+html.
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To check that the Operations Manager Web server is working with 
Apache on Windows: 
http://<server>:<portnumber>/cgi-bin/OVServiceExport.exe?-fo
rmat+html

NOTE The Operations Manager Integration for Windows does not work on 
multiple Service Desk application servers. You can only use it with one 
Service Desk application server, because of limitations in sd_event and in 
the distribution and function of the monitoring policies. 
Chapter 230



Installation
Installing on the Service Desk Server
Installing on the Service Desk Server

If you are running Operations Manager for Windows on a different 
application server than Service Desk, see “Operations Manager for 
Windows Server” on page 32.

No extra components are required on the Service Desk server.
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Operations Manager for Windows Server
Files and tools need to be installed on the Operations Manager servers 
for the integration to work. This section explains the integration 
installation on an Operations Manager for Windows server. 

A table showing the key integration files and default locations for the 
Operations Manager for Windows server, can be found in Chapter 5, 
“Troubleshooting,” on page 75.

To install the integration on your Operations Manager for Windows 
server, follow the instructions in the Readme file distributed with the 
Integration service pack for Operations Manager for Windows 8.0.

Installing the HTML Service Viewer

The HP Operations Manager HTML Service Viewer makes it possible for 
you to view services from a browser. Operations Manager for Windows 
uses a Web Server to perform this function. Refer to the HP OpenView 
Service Desk: Installation Guide for additional information about the 
Web Servers supported. To install the integration you will need to first 
copy OvService Export.exe. to the correct directory.

For Apache users, OvServiceExport.exe needs to be put in a directory 
that Apache can run CGI scripts from (scripts directory).You can find 
this file in the zipped file OvServiceExport, which has been created by 
the integration installation program. The default directory is cgi-bin. 
Apache normally uses the System account when running executable 
files.

For MS-IIS 5.0 you need to put the OvServiceExport.exe file in a 
directory where the Web Server can start CGI scripts. The default 
directory is scripts. You need to modify the OvServiceExport.exe file 
with -cgi cgi root for this directory, for example: -cgi scripts. You 
will need to specify the user and accounts authorized to start the cgi 
scripts.

1. For Windows 2003, from the Start button, select Administrative 
Tools, and then Internet Information Services(IIS) 
Manager.

2. Open Default Web Site.
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3. Click scripts. On the right portion of the screen you will see the 
content of the scripts directory.

4. Right-click scripts and then select Properties.

5. In the Virtual Directory tab verify that the Execute Permission 
parameter is set to Scripts and Executables and click OK.

6. Right-click OvServiceExport.exe on the right side of the window 
and then click Properties.

7. Open the File Security tab.

8. Click on Edit in the Anonymous access and authentication 
control rubric.

9. Enable Anonymous access and click Edit.

10. Specify a user that has the rights to access Operations Manager for 
Windows services, for example: \Management Server\HP-OVE-User 
and the user’s password.

11. Close every window with OK.

NOTE For additional information review the readme.htm file that is included 
with the OvServiceExport tool.
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Multiple Operations Manager Servers
To support multiple Operations Manager servers you will need to:

• Install the Operations Manager Integration on each server.

• Create a separate account in Service Desk for each Operations 
Manager server and specify the host name for each account. The host 
name is used when sending acknowledgments and annotations to the 
Operations Manager server. For example:

Account Host

OVO_account1 server1.yourdomain.com

OVO_account2 server2.yourdomain.com
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Windows and Service Desk 
Configuration
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Configuration tasks need to be performed on the Service Desk and the 
OM servers. Some default settings and values are provided. 
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Overview
This section explains the configuration steps that must be done in 
Service Desk. The tasks are listed below:

• Import managed nodes as configuration items.

• Import services as configuration items.

• Modify the import mapping for events (forwarded messages).

The following will be created automatically:

• Operations Manager Integration account

• The environment variable for Service Desk

• Database rules

• Smart actions

• The environment variable, SD_OVWHOME.

The following configuration tasks need to be done in the Operations 
Manager for Windows application:

• Modify the sd_event.ini file.

• Modify the forwarding policy (not mandatory).

• Deploy the forwarding policy.

• Deploy monitoring policies.

• Deploy opcmsg. 

• Configure Operations Manager tool for viewing configuration items.

Creating an Operations Manager Server Account

Every Operations Manager server that will be integrated with Service 
Desk needs to have a Service Desk account. Windows servers need to 
have an account starting with OVW_. The account and host name of the 
Operations Manager server is used by the database rules to register and 
send acknowledgments and annotations to the Operations Manager 
servers. The default account (OVW_server1) will be created when you 
install your database.
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Keep the following in mind when creating accounts for each Operations 
Manager server you will integrate with Service Desk:

• Accounts must start with OVW, followed with the server host name, 
for example OVW_server1.

• Create non-user interface accounts for integrations.

• Access rights need to include the Helpdesk role as a minimum.

For specific information on creating accounts in Service Desk refer to the 
Administrator’s Guide or the Online Help.

Importing Nodes Into Service Desk

In Service Desk configuration items need to exist for all nodes managed 
by Operations Manager. This step needs to be performed so that events 
coming from the Operations Manager server can find the configuration 
item they are related to in Service Desk. The Operations Manager server 
is also a managed node. 

NOTE Changing any item in Service Desk, for example adding or changing the 
name of a status used for CIs, effects the import mapping used for 
importing nodes. For the import mapping to work completely you will 
either need to modify the template used for the import mapping and fill 
in the right status with the new values for example, or you can modify 
your Service Desk application to match the import mapping.

Import Mapping for Importing Nodes

The import mapping for importing nodes already exists in the default 
database of Service Desk. To support the integration with OMW 8.0, the 
import mapping needs to be updated. The update can be applied by 
importing the ACES file which is located in C:\OVOSD\config\OVSD and 
named ACES_OMW8_Mappings.xml. The updated import mapping for 
importing nodes as configuration items is shown with default values in 
the following figure:
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Figure 3-1 Import Mapping CI Nodes - Windows

For additional information on modifying the import mapping, refer to the 
Chapter entitled “Import Mapping” in the HP OpenView Service Desk: 
Data Exchange Administrator’s Guide.

Configurable Extractor for OMW Nodes

A configurable extractor is used to define how the nodes should be 
exported from the Operations Manager database. An example of the 
extractor file, omw8windowsci.ini, with default settings follows:

om8windowsci.ini file for Operations Manager for Windows and 
Service Desk integration.
; Used for OVW managed node -> SD CI data exchange.

[DSN]
NAME=Openview
USR=
PWD=
Chapter 3 39



Operations Manager for Windows and Service Desk Configuration
Overview
[SYSTEM]
LOG=              TRUE
XML=              TRUE
LOG_FILE=         OVO-WIN.log
XML_OUTPUT_FILE=  OVO-WIN.xml
APPLICATION_NAME= OVO

[CLASSES]
NAME=             MANAGED_NODE

[MANAGED_NODE]
SOURCE=           OV_SD_OW_NODE
ATT=              PRIMARYNODENAME, CAPTION, __RELPATH
COLUMNS=          OV_SD_OW_NODE.PRIMARYNODENAME, 
OV_SD_OW_NODE.CAPTION, OV_SD_OW_NODE.Path AS __RELPATH

This file is installed with the integration and can be found at 
C:\OVOSD\config\OVSD.

Importing Nodes From Operations Manager for Windows

A Data Exchange Task is configured in the demo database for performing 
this action. Nodes can be imported from the Service Desk application 
server as follows:

1. Create an ODBC link. From the Windows control panel, click 
Administrative Tools then ODBC Data Sources. Open the System 
DSN tab and create a new data source named OpenView for the 
connection to the database of OMW. 

2. Execute the program OVSDSync.exe which is installed with the 
integration package. Normally you can find it at C:\OVOSD\bin.

3. Use the Data Exchange task ovowindowsci (for Windows servers) to 
import all managed nodes as configuration items. 
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Figure 3-2 Importing Managed Nodes - Windows

4. Check the log files ovowindows_exp.log and 
ovowindowsci_imp_error.log for errors.

For additional information about how to use Data Exchange for 
exporting and importing data, please refer to the HP OpenView Service 
Desk: Data Exchange Administrator’s Guide.

Multiple Operations Manager Servers

If the Operations Manager for Windows server and the Service Desk 
application server are not located on the same machine, choose one of the 
two following options:

Option 1:

1. On the Service Desk application server, create a new ODBC data 
source that points to the database of OMW.
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2. Export and import the data on the Service Desk application server 
via the Data Exchange task ovowindowsci.

Option 2:

1. Install the Service Desk client on the OMW management server.

2. Create a new ODBC data source that points to the database of OMW 
on the OMW management server.

3. Copy the files (omw8windowsci.ini and omw8windowsservices.ini) 
to the data exchange configuration directory. Normally it should be 
%SD_CLIENTHOME%\data_exchange\config\.

4. Export and import the data via the Data Exchange task 
ovowindowsci on OMW management server.

Manually Creating a Configuration Item 

You can manually create Configuration Items in Service Desk for all or 
part of your managed nodes. To create a configuration item for a 
managed node:

1. Open a new Configuration Item dialog box. This can be done by 
selecting Configuration Item from the shortcut bar or selecting 
New then Configuration Item from the File menu.

2. In the search code field, enter the name of the managed node. 

3. In the Name 1 field, enter the complete host name for the managed 
node:
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Figure 3-3 Configuration Item dialog box

Importing Services Into Service Desk

In Service Desk, configuration items can be made for Operations 
Manager services. A Data Exchange Task is provide with the integration 
for performing this action. Services can be imported from the Service 
Desk application server as follows:

1. Create an ODBC link. From the Windows control panel, click 
Administrative Tools, then ODBC Data Sources. Open the System 
DSN tab and create a new data source named OpenView for the 
connection to the database of OMW.

2. Execute OVSDSync.exe that is installed with the integration 
package. Normally you can find it at C:\OVOSD\bin.

3. Copy the file C:\OVOSD\config\OVSD\omw8windowsservices.ini 
to %SD_CLIENTHOME%\data_exchange\config\.
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4. Verify that the Operational Level Service category is included in 
the OVOService template. See “Creating the Operational Level 
Service Category” on page 44 for details.

5. Use the Data Exchange task ovowindowsservices for Windows 
servers to import all managed services as configuration items.

6. Check the log files ovowindows_exp.log and 
ovowindowsci_imp_error.log for errors.

Creating the Operational Level Service Category

The Operational Level Service category may already be included in 
the OVOService template in your database. The category is used when 
you import Operations Manager services as Service Desk configuration 
items. 

To create the category and add it to the template if it is not present:

1. From the Tools menu select System, then click Data, then Codes, 
and Configuration Item from within the Administrator Console.

2. Click CI Category, then right-click in the screen and select New CI 
Category from the menu that appears.

3. In the New CI Category dialog box enter Operational Level 
Service, in the Text field and leave the Parent field empty:

Figure 3-4 New CI Category

4. Verify that there is no checkmark in the Blocked check box, and click 
Save and Close:
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Figure 3-5 CI Category Operational Level Service

5. Next, you will need to add the new category to your OVOSERVICE 
template. From the Data folder select Templates, then 
Configuration Item. Open the OVOSERVICE template:
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Figure 3-6 OVOSERVICE - Template

6. Double-click the Category entry and use the Quick Find feature to 
locate the Operational Level Service category you created.

7.  Select the Operational Level Service category and click OK to 
add it to the template.

Modifying the Import Mapping for Events

An import mapping with default values, called ovowindows, is provided 
for the Operations Manager integration, you can modify the import 
mapping as needed.

Operations Manager message attributes are mapped to Service Desk 
incident attributes. 
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For detailed information on modifying or creating a new import mapping, 
refer to theHP OpenView Service Desk: Data Exchange Administrator’s 
Guide. 

The default import mapping can is shown in the following dialog box:

Figure 3-7 OM Windows Mapping

Mapping Event Information for Windows

You can send event information from Operations Manager to Service 
Desk using the WMI policy that intercepts OV_Messages and uses a 
Visual Basic script called Ovo-Sd.vbs to call sd_event and forward some 
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of the attributes to Service Desk, creating a corresponding incident in 
Service Desk. The policy must be deployed on the Operations Manager 
management server machine. The attributes are mapped as follows:

Configuring Database Rules

Database rules can be used to send information from Service Desk to 
Operations Manager. A Service Desk agent must be running on each 
Operations Manager server to execute the commands specified in the 
rules. The following sections contain example for setting up rules to send 
annotations and acknowledgments.

Additional information about creating database rules can be found in the 
HP OpenView Service Desk: Administrator’s Guide.

Table 3-1 Default Attribute Mapping - Windows

Properties
Message Attributes Fields

Id Event_id

Test (first 80 char) Description

Original message Information

Original text Information

Application Information

Object Information

Annotation 1 - Annotation n 
(concatenated)

Information

OV_Message.GetInstruction() Solution

OV_ManagedNode.PrimaryNodeN
ame

CI

Severity Impact (mapped)
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NOTE Clear the Blocked check boxes for the action and for the rule to activate 
them.

Send Acknowledgment to Operations Manager for Windows

You can configure a database rule to send acknowledgments to 
Operations Manager for Windows as follows:

Figure 3-8 Database Rule to Send Acknowledgment to OMW

• For each modified incident;

• if [Registration; Create by; Login name]starts with OVW;

• and status is changed to closed;
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Figure 3-9 Action to Send Acknowledgment to OMW 

• on Host: [Registration;Created by;Host]

• execute the command: cscript

• with the parameters: 
/NoLogo "\"%SD_OVWHOME%\\bin\\Ovo-Sd.vbs\"" [Source ID] 
OV_MessageUpdate_Acknowledge

NOTE Please replace %SD_OVWHOME% with the path of the integration, such as 
C:\\OVOSD.

Send Annotations to Operations Manager for Windows

You can configure a database rule to send annotations to Operations 
Manager for Windows as follows:
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Figure 3-10 Database Rule to Send Annotations to OMW

• for each inserted incident;

• if [Registration; Created by;Loginname] starts with OVW;
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Figure 3-11 Action for Sending Annotations to OMW

• execute on host: [Registration; Created by;Host]. 

• the command: cscript

• with parameters:
/NoLogo "\"%SD_OVWHOME%\\bin\\Ovo-Sd.vbs\"" [Source ID] 
OV_MessageUpdate_AddAnnotation "\"A Service Desk incident 
has been created with number [ID]\""

NOTE Please replace %SD_OVWHOME% with the path of the integration, such as 
C:\\OVOSD
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TIP Create new database rules quickly by using the copy and paste functions. 
Select a rule that is similar to the rule you want to create and click 
CTRL+C then CTRL+V to make a copy. Double-click the copied rule to open 
it and then use the database rules Wizard to change the parameters and 
the name.

View Operations Manager State from Service Desk

You can view current Operations Manager Service State from a browser 
in Service Desk. See “Installing the HTML Service Viewer” on page 32, 
and “Viewing Operations Manager Service State” on page 71 for more 
information.

NOTE If you are using smart actions to view service statuses, your Operations 
Manager Web site needs to be entered in the parameters portion of the 
smart action. Normally the Web site will be the same as your Operations 
Manager server.

TIP A number of functions available with this integration use the Smart 
Actions feature in Service Desk. To create a new Smart Action:

1. From the Tools menu, select System, then click Business Logic, 
Actions, then Smart Actions.

2. Click the item that you want to create a smart action for. For 
example; a configuration item or a Service Call.

3. Right-click and select New Smart Action from the popup menu.

Additional information on setting up and using Smart Actions can be 
found in the Online Help for Service Desk. 
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Generate an Operations Manager Message from 
Service Desk

The Generate OVO message manually Smart Action can be used to 
forward an Incident to the Operations Manager operator. If configured 
correctly this manually generated message will not cause the automatic 
trouble-ticket interface in Operations Manager to generate a new 
incident in Service Desk. 

First make sure the Operations Manager Agent is installed on the 
Service Desk Client. The default location is: C:\Program Files\HP 
OpenView.

The opcmsg application can be found in the same folder. The system 
environment variable PATH contains the exact path to this program, so 
that it can be called without specifying the folder location. The opcmsg 
application can be used to forward field information from a Service Desk 
incident to the Operations Manager Management Server. 

To set up the opcmsg application:

1. Open the Administrator Console in Service Desk, then click Business 
Logic, and then open Applications.

2.  Right-click and select New Application from the menu. Define the 
application as shown in the following dialog box:

Figure 3-12 Opcmsg Application

3. Next, create a Smart Action using the opcmsg application as follows:
Chapter 354



Operations Manager for Windows and Service Desk Configuration
Overview
Figure 3-13 Generate OM Message Manually

The parameters entered determine what information from the Incident 
will be passed to the Operations Manager application. The parameters 
use the Operations Manager application’s opcmsg syntax. In the example 
above a equals Application, and o equals Object. 

Your system administrator will need to provide access to this smart 
action for all clients that will be using it. The opcmsg command will also 
need to be deployed to the host machines of the Service Desk clients that 
will use the command. Only then will it be possible to execute opcmsg to 
log an event in the Operations Manager Management Server’s Active 
messages window from remote client machines.

For more information on deploying opcmsg, see “Deploying opcmsg to 
Service Desk Clients” on page 58.

To stop Operations Manager from forwarding the message to Service 
Desk, creating a duplicate incident, the Forward Message to Service 
Desk policy should be configured so that it does not forward messages to 
Service Desk that originated from Service Desk. The messages will 
remain in the Operations Manager browser.

Operations Manager for Windows users can use the 
ForwardTroubleTicket:flag to control the forwarding of events 
(messages) to Service Desk. This option can be turned on or off in the 
templates by the Operations Manager operator. 
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Operations Manager for Windows
This section explains the configuration tasks to be done in the 
Operations Manager application. For an overview of all configuration 
tasks, see “Overview” on page 37.

Installing the Policies for Integration

There are four policies that need to be installed on the OMW 
management server:

1. Forward messages to Service Desk

2. Forward message changes to Service Desk

3. Monitor sd_event logfile

4. Monitor Service Desk logfile

You can install these policies by executing the script file 
C:\OVOSD\config\OMW\ovopolicies.bat.

Modifying the Settings of SD_Event

Modify the SD_Event setting file, sd_event.ini. The default location is: 
C:\OVOSD\bin . Many of the items will be configured automatically for 
you during the installation process. You will want to update the ACCOUNT 
and SERVER entries, as a minimum. If you changed the name of the 
import mapping supplied with this integration, you will need to enter the 
new name in the MAPPING row. A copy of the example sd_event.ini file 
follows:

[SD_Event]
LOGFILE=C:\OVOSD\log\sd_event.log
ERROR_LOGFILE=C:\OVOSD\log\sd_event_error.log
ACCOUNT=OVW_server1/Servicedesk
SERVER=your server
PORT=30980
MAPPING=ovwindows
CLASSNAME=incident
MODUS=insert
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Modifying the Forwarding Policy

The policies called Forward message to Service Desk and Forward 
message changes to Service Desk are configured to forward all major 
and critical messages that are not log only. You can specify what 
messages are forwarded by editing the conditions of the policy. To edit 
the policy:

1. Right-click on the Forward message to Service Desk policy and select 
All Tasks, then Edit.

2. In the Rules tab, click Modify. 

3. Click Add or Modify to change the conditions for each rule.

For additional information refer to the Online Help in your Operations 
Manager for Windows application.

Deploying the Forwarding Policies

The policies called Forward messages to Service Desk and Forward 
message changes to Service Desk need to be deployed on your 
application server every time you make a change. To deploy the policy:

1. Right-click on the policy and select All Tasks, then Deploy On.

2. Select your management server node you want to deploy it on.

3. Click OK.

For additional information refer to the Online Help in your Operations 
Manager for Windows application.

Deploying the Monitoring Policies

Policies are supplied to monitor this integration. After installing the 
integration you need to deploy the policies to the proper locations. The 
list below shows the policies and where they need to be deployed:

Monitor sd_event logfile Operations Manager management 
server

Monitor Service Desk logfile Service Desk server
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Deploying opcmsg to Service Desk Clients

Opcmsg is used to create Operations Manager messages from Service 
Desk. You need to deploy this policy to all Service Desk clients that you 
want to be able to perform this function from. To deploy the policy:

1. In the Operations Manager management console, open Policies 
grouped by type.

2. Open the Open Message Interface policy group.

3. Select the opcmsg policy, right-click and then select All Tasks, then 
Deploy on. 

4. Select all of the Service Desk client nodes that you want to be able to 
manually create OMW messages from and click OK.

For additional information refer to the Online Help in your Operations 
Manager for Windows application.

Configuring Operations Manager Tools

An Operations Manager tool is supplied with this integration for viewing 
Service Desk configuration items when you have the related node 
selected in Operations Manager. After installing the integration, you 
need to configure the target nodes for the tool. Tools can be:

• run on the nodes you specify;

• configured to permit users to choose the nodes on which the tool will 
run;

• run in the context of a service (run on the node that hosts that 
service).

Use the Target tab in the Tool Properties dialog box to select the nodes 
on which you want the tools to run. You must also specify Node List in 
the Execute On list. This configures the tool to run on all the nodes in 
the Predefined Node List. 

If you prefer to allow your users to determine where a tool is to be run, 
you must choose Selected Node in the Execute On list. When the tool is 
executed, a list appears from which users choose the location (service or 
node) where the tool will run.

For additional information on using Operations Manager Tools, refer to 
the Online Help in the Operations Manager for Windows application.
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Viewing Service Desk CIs from Operations Manager

This section shows how to configure an Operations Manager for Windows 
tool to open a Service Desk configuration while working in Operations 
Manager. 

In your Operations Manager for Windows application:

1. Open the Tool Properties dialog box and enter a name for the tool in 
the General tabbed page:

Figure 3-14 Show Configuration Item - General tab

2. Open the Details tabbed page and enter Executable in the Command 
Type field:
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Figure 3-15 Show Configuration Item - Details tab

3. In the Command field enter wscript.exe.

4. In the Parameters field enter "C:\OVOSD\bin\ShowOVSDCI.vbs" 
"Configuration Item" "Searchcode" "$OPC_NODES".

If you used the default import mapping to import node information, 
PrimaryNodeName data is imported into the Configuration Item field 
Searchcode. It is recommended that you use unique search codes to 
prevent errors.

5. In the Target tabbed page enter Console in the Execute On: field. 
This will allow the program to interact with your console:
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Figure 3-16 Show Configuration Item - Target tab
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4 User Tasks

This chapter provides some examples of how this integration can be 
used. Each section contains at least one task description, and lists the 
steps for performing the task for Operations Manager for Windows as 
applicable. 
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Importing Nodes into Service Desk
Operations Manager nodes are equivalent to configuration items in 
Service Desk. For Service Desk to relate incidents to a piece of 
equipment, that equipment or node needs to be registered as a 
configuration item. Data Exchange is used to automate the process of 
extracting the node data from Operations Manager and import the nodes 
as configuration items in Service Desk. 

To export nodes from Operations Manager for Windows and import them 
as configuration items in Service Desk, use the Data Exchange task 
called ovowindowsci from the Service Desk application server.

NOTE The default configuration for this Data Exchange task cannot detect 
deleted or outdated nodes. For example, you import all nodes into Service 
Desk as configuration items. Six months later, 30 of your nodes are 
replaced by more modern equipment. You can reconcile your data 
exchange data and use the change list produced to identity obsolete 
items. See the Reconciliation section in the HP OpenView Service Desk: 
Data Exchange ADministrator’s Guide.
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Importing Services and Relations
Operations Manager service information can be imported as 
configuration items into Service Desk using the Data Exchange feature. 
This makes it possible to relate Service Desk incidents to Operations 
Manager services. Dependency and composition relations are also 
imported. Dependency relations are horizontal. For example, the 
purchasing system and the human resource department are both 
dependent on an Oracle database. Composition relations are parent-child 
relations. For example, E-mail service is the parent of the US E-mail 
service and European E-mail service. The relations are added to the 
Related CIs field of the configuration item when they are imported.

To export services from Operations Manager for Windows and import 
them as configuration items in Service Desk, use the Data Exchange 
task called ovowindowsservices from the Service Desk application 
server. For specific information, see “Importing Services Into Service 
Desk” on page 43.
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Sending Events From Operations Manager
Service Desk can be used as the Trouble Ticket interface for Operations 
Manager. You can configure Operations Manager to send all events or 
specific events to Service Desk. The event information is mapped to a 
Service Desk incident. The first time an event is sent, an incident is 
created in Service Desk. Service Desk is then the owner of that event. 
The import mapping in Service Desk defines which event attributes will 
be imported into the Incident fields.

If you are using Operations Manager for Windows, you can send event 
information from Operations Manager to Service Desk using the WMI 
policy called Forward messages to Service Desk that intercepts 
OV_Messages and uses a Visual Basic script called OVO-Sd.vbs to call 
sd_event and forward attributes to Service Desk. SD_event creates a 
corresponding incident in Service Desk. The policy must be deployed on 
the Operations Manager management server.

To send event information from the Operations Manager for Windows 
management console to Service Desk:

1. Configure the integration, see “Deploying the Forwarding Policies” 
on page 57.

2. Once configured, event information that meets the conditions set for 
the policy will automatically be sent to Service Desk. To change what 
message information is sent to Service Desk you will need to modify 
the conditions and distribute the changed policy to your client 
computers. See “Modifying the Forwarding Policy” on page 57.
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Reflecting Updates Done in Operations 
Manager
Changes made to Operations Manager messages from the Operations 
Manager for Windows management console or the API will be reflected 
in Service Desk. 

A WMI policy that registers the event class OV_Message_ChangeEvent is 
used. When a message change occurs, for example severity change, 
message text change, the sd_event program in Service Desk will be 
called to update the corresponding incident.

To reflect updates done in Operations Manager for Windows in your 
Service Desk application:

1. Install and configure the integration.

2. Once the Forward message changes to Service Desk policy is 
distributed, message updates will be sent to Service Desk 
automatically. The import mapping determines what attributes are 
sent to Service Desk.
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Sending Annotations to Operations Manager
Annotating a message in Operations Manager is similar to adding a note 
of explanation to a business contract. The annotation is a short 
summation of the important points and can be used as a reference the 
next time you receive the same message. Message annotations are 
normally used to provide information on:

• action performed to resolve the problem;

• name of the user who started the action;

• status information for the action performed;

• start and finish time of the action;

• any pre- or post action information which is relevant.

Database rules are available in the demo database for sending an 
annotation to Operations Manager whenever an incident is created as a 
result of an event being sent from Operations Manager to Service Desk. 
The database rule can also be configured to send an annotation to the 
Operations Manager application whenever the status of that incident 
changes. Database rules can be turned on/off and modified from the 
Service Desk. Service Desk agents on the Operations Manager servers 
are sent commands, generated from a database rule in Service Desk, that 
call the OVO-Sd.vbs script in Operations Manager.

Once the integration is installed and configured, an annotation is send 
whenever Service Desk receives an incident from Operations Manager. 
Optionally, whenever a Service Desk user updates the incident’s 
information, an annotation is also sent to Operations Manager.
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Sending Acknowledgments to Operations 
Manager
Acknowledging a message is similar to filing a bill after it is paid. You 
want to retain a copy of the transaction to verify that you have paid the 
bill, and as a reference to compare with future bills. After you have 
finished working with a message you remove it from your desktop and 
file it away for easy future reference. Typically you acknowledge a 
message because:

• You have finished work on the message and resolved any related 
problems.

• You have another message in your Message Browser describing the 
same event.

• You no longer need the message, for example, if the message has low 
severity and requires no action.

Database rules are available in the demo database for acknowledging 
messages from Operations Manager whenever an incident that was 
created as a result of an Operations Manager event is closed in Service 
Desk. Agents on the Operations Manager server are sent commands, 
generated by a database rule in Service Desk, that call the OVO-Sd.vbs 
script in Operations Manager.

Once the integration is installed and configured, whenever an incident 
from Operations Manager is closed in Service Desk, an 
acknowledgement is sent.
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Viewing Service Desk CIs from Operations 
Manager
While working in Operations Manager for Windows you can view related 
configuration items in Service Desk. 

The View Node Info action opens the configuration item form in Service 
Desk. The node selected is passed as a parameter using $OPC_NODES. 
The application can only be started with the Windows user interface.

See “Viewing Service Desk CIs from Operations Manager” on page 59 for 
information on how to set up the tool to perform this action in Operations 
Manager.

Operations Manager for Windows - View 
Configuration Items

To call the Service Desk user interface when you are working in the 
Operations Manager for Windows management console:

1. Select the node that you want to view as a configuration item in 
Service Desk.

2. Right-click and select All Tasks, then Launch Tool.

3. In the Tool to Execute dialog box, select Show Configuration Item 
in Service Desk Client. 

4. Click Launch.

NOTE In addition to nodes, it is also possible to view incident information. The 
procedure is the same as described above, except that you select a 
message instead of a node. If the node or message you select is not known 
to Service Desk, the Service Desk user interface is opened with a new CI 
or incident window.
Chapter 470



User Tasks
Viewing Operations Manager Service State
Viewing Operations Manager Service State 
A browser can be used to view all services that are not working or just 
top level services that are not working, depending on the URL used. The 
services are color coded to show the level of importance: red equals 
critical; orange equals major; yellow equals minor; and light blue (Cyan) 
equals warning. The following scenarios are designed to give you an idea 
of how this feature might be used:

• A support manager wants an update on the state of the top level 
Operations Manager services that are down. The manager clicks the 
Top OVO services shortcut on the desktop and gets a view of all top 
level services currently down.

• A specialist is working at a customer site and needs an update on the 
services that are down. The specialist enters the service viewer URL, 
in the browser of a computer with Internet access, and gets a view of 
all services that are down. 

• The customer support center begins to receive numerous calls for 
service. To get a quick overview of services that are currently down 
the help desk engineer uses the Service viewer shortcut on the 
desktop to quickly locate the down service and answer the calls.

There are two Smart Actions available for viewing Operations Manager 
services. Services can be viewed for a service call, an incident, or for a 
configuration item. To view the services, from the Action menu in 
Service Desk, select Show OVO for Windows service state.

Alternatively, add a shortcut to view the overall state of Operations 
Manager services. To create the shortcut:

1. From the Start menu select Programs and then left-click on the 
entry for Service Desk 4.5. 

2. Select Add Shortcut from the popup menu that appears.

3. In the Name field, enter the name you want the shortcut to have and 
select the URL option with the following URL: 
http://server/cgi-bin/ovserviceexport.exe?-format+html[+
-service+service name.]

For viewing top services, remove the service name from the end of 
the URL.
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4. Click OK to save the shortcut. 

5. When you click on the shortcut a hierarchical view of services will be 
visible. Click each service to view more detail information. The view 
will be refreshed every sixty seconds.
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Generating an Operations Manager Message 
From Service Desk
If a helpdesk employee becomes aware of a problem in the IT 
infrastructure and creates an incident in Service Desk. However, an 
error message does not exist for the problem in the Operations Manager 
application. The helpdesk employee, can use a smart action in Service 
Desk to pass the incident information to the Operations Manager 
application, creating a new error message in Operations Manager. 

To generate an Operations Manager message from the Service Desk 
client user interface:

1. Select or open an incident in Service Desk.

2. From the Actions menu in Service Desk, click the Generate OVO 
message manually action.

3. A new message will be created in Operations Manager.
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Monitoring Service Desk Processes
In Windows, Operations Manager policies can be used to monitor the log 
files for the Service Desk agent, sd_event, and the Service Desk 
application server. This provides you with a means for monitoring the 
integration continuously. The policies can be used to match specific log 
file lines and assign variables out of the intercepted lines to use for 
pattern matching.

Once the policies are deployed, detected errors are sent to the message 
browser automatically. Instructional text is provided with the error 
messages to help solve detected problems. Use the policy monitor 
sd_event logfile monitor sd event log file to monitor the integration 
tool sd_event Use the policy monitor sd_event logfile to monitor the 
integration tool sd_event. Use the policy Monitor Service Desk 
logfile for monitoring the Service Desk application server.
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5 Troubleshooting

This chapter contains troubleshooting information for using the 
Operations Manager operation Windows with Service Desk.
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Troubleshooting Information
This section contains information that may be helpful in locating and 
solving errors that occur when using this integration.

Potential Windows Error Messages

This section explains error messages you may encounter in 
sd_event_error.log, followed by a possible solution.

Viewing Items Error

Error message: You are not allowed to view this type of item.

Solution:

1. From the Tools menu in Service Desk, click System, then Security, 
then Access, and Role.

2. Open the Helpdesk role and select View access for the Account 
item.

3. Click OK and then restart the Service Desk application server.

Integration Item Reference List

The following tables are provided to give you an overview of the various 
files and configured items included in this integration and their use. The 
tables include the various import mappings, configuration files, policies, 
database rules, smart actions and other key tools provided with this 
integration:

Table 5-1 Configuration (ini) Files

Name Use

sd_event.ini For importing events into 
Service Desk.

omw8windowsci.ini For importing OM for Windows 
nodes as configuration items 
into Service Desk.
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omw8windowsservices.ini For importing services from OM 
for Windows into Service Desk.

Table 5-2 Import Mapping

Name Use

ovowindowci For mapping OMW nodes to 
configuration item and 
attributes in Service Desk.

ovowindowsservices For mapping services from 
OMW to Service Desk 
configuration items.

Table 5-3 Database Rules in Service Desk

Name Use

Send acknowledgments to OVO 
for Windows

For sending an 
acknowledgements to 
Operations Manager for 
Windows.

Send annotations to OVO for 
Windows.

For sending annotations to 
OMW.

Table 5-4 Smart Actions in Service Desk

Name Use

Generate OVO message manually To manually insert a Service 
Desk incident as a message in 
OMW.

Show OVO for Windows service 
state

To view the state of Operations 
Manager for Windows services 
with a Web browser.

Table 5-1 Configuration (ini) Files (Continued)

Name Use
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Table 5-5 Policies in OMW

Name Use

Forward messages to Service 
Desk

To forward a message from 
Operations Manager to Service 
Desk.

Forward message changes to 
Service Desk

To forward message changes 
from Operations Manager to 
Service Desk.

Monitor Service Desk log file To monitor the Service Desk log 
file for errors.

Monitor sd_event log file To monitor the sd_event log file 
for errors.

Table 5-6 Tools in OMW

Name Use

Show Configuration Item in 
Service Desk Client

To view the configuration item 
in Service Desk that is related 
to the node selected in 
Operations Manager.

Table 5-7 Accounts in Service Desk

Name Use

OVW_server1/servicedesk Default account created for the 
Operations Manager for 
Windows server. Server 
accounts must start with OVW.

Table 5-8 Monitoring Policies in OMW

Name Use

Monitor sd_event logfile For monitoring sd_event on the 
Operations Manager 
management server.
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Installation Reference Tables

Monitoring Service Desk 
Logfile

For monitoring the Service Desk 
application server.

Table 5-8 Monitoring Policies in OMW (Continued)

Name Use

Table 5-9 Service Desk Server

File Default Location

ovowindowsci.ini Service Desk product 
path\data_exchange\config

ovowindowsservices.ini Service Desk product 
path\data_exchange\config

sd_access.exe Service Desk product path\bin

sd_access /opt/OV/sd/server/bin

Table 5-10 Operations Manager Server - Windows Platform

File Default Location

sd_event.exe
sd_event.ini
Ovo-Sd.vbs
queuectl.exe
enqueue.exe
dequeue.exe
ShowOVSDEntity.vbs

C:\OVOSD\bin
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Monitor Service Desk logfile 
(policy)
Monitor sd_event logfile 
(policy)
Forward messages to Service 
Desk (policy)
Forward message changes to 
Service Desk (policy)
ovopolicies.bat
config.mm

C:\OVOSD\config\OMW 

ACES_OMW8_Mappings.xml
omw8windowsci.ini
omw8windowsservices.ini

C:\OVOSD\config\OVSD

Table 5-10 Operations Manager Server - Windows Platform (Continued)

File Default Location
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A Sample File Contents

This appendix presents listings of example configuration files provided 
with the integration.
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sd_event.ini
sd_event.ini
This file is used to configure the setting of sd_event, which is a tool for 
sending the OMW message to OVSD side. For more information, see 
“Modifying the Settings of SD_Event” on page 56.

[SD_Event]
LOGFILE=C:/OVOSD/log/sd_event.log
ERROR_LOGFILE=C:/OVOSD/log/sd_event_error.log
ACCOUNT=OVW_server1/password
SERVER=yourserver
PORT=30980
MAPPING=ovowindows
CLASSNAME=incident
MODUS=insert
LANGUAGE=EN_US
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